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NJ-GeoWeb 
 

NJ-GeoWeb is a free and easy to use customized interactive web application to view, query, and 
analyze both local and state-wide areas of interest and environmental information. 

 
Launching the Application 

 
The link to launch the application can be found on the following webpage: 
https://www.nj.gov/dep/gis/geowebsplash.htm 

 
 
 
 

 

Then click “Launch GeoWeb” 
 

The splash screen for the application will then open: 
 

 

Click “OK” to begin 

http://www.nj.gov/dep/gis/geowebsplash.htm
https://njdep.maps.arcgis.com/apps/webappviewer/index.html?id=02251e521d97454aabadfd8cf168e44d
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Application Tips: 
 

If all tool icons are not visible upon startup, it may be due to the user’s screen resolution. 
Click the More icon to view the full tool list. If the layer list is not fully visible, the browsers 
zoom level may need to be adjusted. 

 
 

To restore the map and layers from the most recent configuration, click 
the App State button in the bottom right corner of the app upon 
startup. Previous app configurations can also be shared using the 
Sharing Tool. 

 

Application Overview: 
 
 

 
 
 

The NJ-GeoWeb’ s interface consists of a map view frame, tools to access and use data, tools to navigate 
around the map view frame, filters, parcel search, drawing, and layer selection. The following provides a brief 
description of the tools and steps to use each functionality. 

4. Address Search 

3. Map 
Information 
Tools 

5. NJDEP/BGIS Links 
 

6. Application Tools 

2. Map Navigation Tools 

1. Map Viewer 

8. Scale Bar & XY Coordinates 
7. Attribute Table 
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1. Map Viewer – Interacting with the Map 
To pan around the map, click and hold the left mouse button while moving to an area of interest. 

Use the scroll wheel on the mouse to zoom in and out of the map. 

Users can also zoom into the map by holding down the Shift button on the keyboard and selecting 
an area to zoom into. A red box will appear indicating the selected zoom area. 

 
 
 
 

 
Map Pop-ups 

Click on features within the map to reveal a pop-up window with information about that point of in- 
terest. If features overlap, use the arrow button at the top-right of the pop-up to scan through all 
features. To view further related table information, users can click the related tables at the bottom 
of the popups. 
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NOW IT’S YOUR TURN! 

• Pan around the map, using your mouse. Zoom in and out, via the scroll wheel. 
• Now try to zoom into the Trenton region, utilizing the keyboard Shift key, and activate the red selection 

box. 
• Left click on the mouse, to activate the map pop-up. 

◊ Note that the only information provided is from the County layer, which is loaded into the map 
by default, when the application is opened. 

 
 
 
 

2. Map Navigation Tools 

Use the tools at the upper left to navigate the interactive map: 
 

Zoom In/Out: Zoom in and out of the map view. 
 
 
 

  Default Extent: Click this to return to the full view of New Jersey. 

  My Location: Allow users to zoom to current location when using a mobile device. 

Extent Navigation: Allows users to navigate the map to its previous or next extent. 
 
 
 

 
NOW IT’S YOUR TURN! 

• Explore an area of the map, using the Zoom In/Zoom Out Tool 
• After you’ve zoomed around, return to the map’s original extent, via the Default Extent tool. 
• If you are accessing the application on a mobile device, try to locate your geographic position with the 

My Location tool. 
• Return to your previous extent, but clicking on the left arrow of the Extent Navigation tool 
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3. Map Information Tools 
 

Map/Data tools can be found in the upper left corner and beneath the address search bar. 
 

Legend: The Legend displays labels and symbols for the layers in the map (only layers with their 
visibility turned on will display in the legend). View the symbology of the point, line, polygon data 
on the map interface. Legend will also be displayed in the printed map. 

 

 
Basemap Gallery: The Basemap Gallery presents a gallery of basemaps for the user to select from. 

 
 
 
 

Share: The Share tool allows the user to share an app by sending an email with a link or embed- 
ding it in a website or blog. An option to remember the layer visibility is also available. This op- 
tion allows the user to share their current view of the app with another user. 

 
 
 

NOW IT’S YOUR TURN! 
 

 
• Click on the Legend Tool and note its behavior - 

County Boundaries appears in the list. 
 
 
 
 
 
 
 

•  Now click on the Base map Gallery Tool, and experiment with some of 
the available background imagery. 
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4. Address Search 
 

The Search Bar enables the user to find 
locations within the map. The search 
can find locations using names or 
addresses. Latitude and longitude 
coordinates can also be used. 

Now Try sharing your map (hint- email to 
yourself to verify your Share selections) 

 
◊ Click on the Share Tool 
◊ Click on Link options 

 
• Experiment with the different 
configurations available 

 
◊ Click the Share button, then copy/paste 
the link into an email or other document, 
from which it can be opened. 

 
 
 

NOW IT’S YOUR TURN! 

• Enter an address in the “Find address or place” box, click “Enter” 
• Note that the map zooms to the address or place you entered. 
• Also note that the parcels layer has been activated and is visible. 
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5. NJDEP/BGIS Links 
 

 
 

Users can find more information about the NJDEP or the Bureau of GIS by using these links. 
 
 

NOW IT’S YOUR TURN! 

• Click on the “New Jersey Department of Environmental Protection” link to view the department’s 
general, highest level online resource. 

• Click on the BGIS link to access the bureau’s online resources. 
 
 

 
 
 
 

6. Application Tools 
 

 
The Application Tools are in the toolbar located at upper right in Map Viewer. 

Most of the functionalities such as searches, queries, analyses, and printing are on the main toolbar. The 
tools for this document are not described in the order they appear in the toolbar 

 
 

Parcel Search: The Parcel Search is one of the application’s most powerful tools. Users can use the 
Parcel Search tool to search for parcels by County, Municipality, Block, and Lot. 

 
Users can export the searched parcels by selecting the Export button within the results tab (3 dots) 
of the “Output” tab and choosing the selected export method. 
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NOW IT’S YOUR TURN! 

• Let’s do a parcel search for Trenton City Hall: 
◊ In the “County and Municipality” drop-down, select MERCER- Trenton City 
◊ For “Block” enter 301 
◊ For “Lot” enter 1 
◊ Click “Run” 
◊ The map zooms to City Hall at 319 E State St., Trenton 

• We’ll now explore the Export functions in the Parcel Search Tool 
◊ Click on the “Output” button, the click on the results tab (3 dots) 
◊ There are three export options: 

• Export to CSV file- creates a csv spreadsheet file. 
• Export to feature collection- a type of feature layer that holds static collections of 

features stored as JSON inside a map or portal item 
• Export to GeoJSON- represents simple geographic features and their non-spatial 

attributes. 
◊ Experiment with the other options available in the Output button (Zoom to, Flash, Show pop-up, 

etc.). 
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Note : To perform multiple parcel search, use custom layer filter tool. Click here to learn more. 

 

 
Searches: Users can select from a variety of searches to interact with multiple environmental layers. 

These layers include: 
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In the example below, we selected the “Historic Districts” Search, and used “12th Street Streetscape” as our 
Cultural Resource name. 

 
 

 
 
 
 

After a search is completed, users can take further actions on 
selected features by selecting the 3 dots in the Results tab. This 
menu has more capabilities with the results of the query (the 
list of available options varies depending on the permissions on 
the layer being queried): 

• Zoom to – zoom to the highlighted feature 
• Pan to – pan over to the highlighted result 
• Flash – the highlighted feature will flash to make more visible 
• Show pop-up – attributes of a feature in the form of a pop- 

up 
• Export to CSV file/feature collection/GeoJSON – exports of 

the results 
• View in Attribute Table – attribute table will display from the 

bottom of the viewer 
• Zoom to – zooms to the selected record item om the map 
• Remove the result – clear the result 
• Show all related record – this option is only available if there 

are related tables linked to the layer that is being queried 
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NOW IT’S YOUR TURN! 

We’ll now do a search for a known contaminated site (KCS) in Trenton: 
◊ Turn on the Known Contaminated Sites List layer: Layer List > Sites and Facilities > Known Contaminated 

Sites List 
◊ Under Searches Tool – Select the “Known Contaminated Sites List” search 

• “County” is Mercer 
• “Municipality” is Trenton City 
• “Contaminated Site List Name is” 160 PENNINGTON AVE 
• Click “Apply” 

◊ Map zooms to KCS selected, with attribute data on site visible. 
 
 

 
 
 

Near Me: The Near Me tool allows users to find Site and Facility features within a buffer of a 
defined address or location and view detailed information about those features. Only features 
turned on within the Layer List will be included in the Near Me analysis.  

 
 

Users can then click on the results to view more information. 
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NOW IT’S YOUR TURN! 

Let’s determine if there are any features near the main DEP headquarters in Trenton: 
• Before performing the Near Me analysis, turn on any layers of interest from the Layer List 

◊ Known Contaminates Site List (Sites and Facilities) 
◊ New Jersey Environmental Management System (NJEMS) Sites (Sites and Facilities) 
◊ Underground Storage Tank Facilities (Sites and Facilities) 

• Set “Show results within (Feet)” to 300, then enter “401 E State St, Trenton” into the search bar. 
• select “Search” icon. 
• The Near Me tool returns all the features found within 300 feet of the target. 
• You can click on any of the features in the list for additional attribute data. 

 
 

Results of Near Me search in column at right Expanded results for “Underground Storage Tank Facilities” 
 

 
• Click on the Set location button, then click on any site on the map 

◊ The Near Me tool returns all features found within 300 feet of the random point 
you selected 

 

 
Custom Layer Filter: The Filter tool allows users to limit visibility of features in a layer. Only 
features that meet the set criteria will be visible in the map. 

 
 

• Select the Create a Custom Filter to get started. 

◊ Then select the layer to create a custom filter on. 

◊ Add an expression or a set of multiple 
expressions. 

◊ Finally, select the field, condition, and 
input type to create the filter. 
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NOW IT’S YOUR TURN! 

• We will now create a filter that allows us to Electric Alternative Vehicle Fueling Stations within the state. 
◊ Be sure that the Alternative Vehicle Fueling Stations layer is turned on in Layers list > 

Transportation 
◊ Select the Custom Layer Filter, and be sure to activate it (“push” slider to right) 
◊ In the “Layer” pull-down, select Alternative Vehicle Fueling Stations 
◊ Select “Add expression” (lower right) 
◊ In the top pull-down, select Fuel Type (String) 
◊ Set next pull-down to “is” 
◊ Click “gear” icon, select Unique 
◊ Select Electric 
◊ Only electric fueling stations are visible- toggle the custom filter slider back and forth to turn the 

filter on/off.  
 
 

 
 
 
 

Draw: The Draw tool provides basic sketching and markup functionality. The window also 
displays some measurements for drawn features, such as lengths for lines, and areas and/or 
perimeters for polygons. 
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NOW IT’S YOUR TURN! 

• Let’s draw some features for the NJDEP headquarters 
◊ Zoom to 401 E State St, Trenton 

• Add Text: 
◊ Select the “A” button to add text. 
◊ Type “Department of Environmental 

Protection.” 
◊ Change the font size to 12. 
◊ Click on the building of 401 E State St. 

• Add a point: 
◊ Select the Point marker. Choose a point image 

of choice. 
◊ Change the font size and color. 
◊ Click on the map to add the drawn point. 

 
 
 
 
 

Select: The Select tool allows the user to interactively select features on the map and take 
actions on the selected features. Clicking the 3 dots next to the selected features will open the 
Show Actions options. Within these options, users can export selected features to CSV, Feature 
Collection, and GeoJSON. 
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NOW IT’S YOUR TURN! 

We will now select autobody shops in Trenton 
• Turn on the Autobody Shops layer 

◊ Layer List > Sites and Facilities > Autobody Shops 
• Zoom into Trenton (street level) to view the autobody shop point features 
• Find the Autobody Shops layer in the Select layer list 
• From “Select” pull-down, choose “Select by point” 
• Click on one of the autobody shop points on map 
• Click on the three dots in the layer list for the autobody shops: the “Selection actions” menu opens 

◊ Choose the “Zoom to” option to inspect parcel up-close 
◊ Choose the “View in Attribute Table” option to view the autobody shop’s attribute data 

 
 
 

 
 
 
 

Measure: The Measure tool allows the user to measure the area of a polygon, the length of a line, or 
find the coordinates of a point. Users can change the units of measurements from the drop-down. 

 
Area –Click and draw a polygon on the map. Double click to finish the drawing and the 

measurement result will appear in the Measure window. 
 

Distance - Click and draw a line on the map to measure the distance. Double click to finish the 
drawing and the measurement result will appear. 

 
Location - Click to place a point on the map to view the latitude and longitude. A green marker will 

appear in the Measure window. 
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NOW IT’S YOUR TURN! 

Measure the distance from 401 E State St Trenton, NJ 08608 to New Jersey State House in miles: 

• Open Measure > Distance. 
• Click on 401 E State St, Trenton, NJ 08608. A green place marker appears 
• Double click on New Jersey State House. A blue line follows a second green place marker. The distance 

in miles shows in the results. 
 
 
 

 
 
 
 
 

Swipe: The Swipe tool enables the user to easily compare the content 
of different layers in a map. Once the tool is turned on, select a  
single layer or multiple layers to swipe from the drop-down list. 

 
 
 
 
 

NOW IT’S YOUR TURN! 

We will swipe between a base map and a layer containing impervious surface data 

• From the Base Map Gallery, select the “Imagery” map 
• Add the Impervious Surface % (2012) from the Layer List (Land) 

• Be sure the impervious surface layer is chosen in the “Swipe layer” drop-down 
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Screening: The Screening tool allows users to define an area of interest and analyze specified 
environmental layers for potential impacts. Areas of interest can be defined through a place 
name search or by drawing on the map. 

 
 
 
 
 
 

Analysis results can be inspected in the tool and, 
optionally, shared via a printed report or CSV file 
download. 

In the Report pane the user can upload Shape files and 
Zipped Shapefiles to be used within the analysis. 

 
 
 
 
 
 
 
 

 
NOW IT’S YOUR TURN! 

Let’s screen a diameter around Trenton, and determine which data features can found: 

• Select the Screening tool. 
• Type “401 E State St, Trenton” in the “Search for a location” box. 
• For “Buffer distance”, enter “500”, and “Feet” from the drop-down. 
• Click “Report”. 
• The Screen Tool then generates a list of all map data features found within 500 feet of the target 
• You can then click on any of the screen features to obtain their attribute data. You can also download 

the data as a CSV file, or print a report. 
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XY Coordinate Search: The XY Coordinate Search allows users to plot NAD 1983 State Plane XY 
Coordinates on a Web Mercator map. This may be useful to those who do not have a specific 
address but collected coordinates with GPS units. 

 
 

NOW IT’S YOUR TURN! 

• Open the Locate Tool 
◊ Add 420357in Easting (X) and 505404in Northing (Y). (These units are in 1983 NJ State Plane Feet) 
◊ Click “Run” 
◊ The map zooms in/creates a blue point for the desired coordinates (these are the coordinates for 

the NJ DEP building) 
 
 

 
 
 
 
 
 
 
 

Print: The Print tool allows users to print their 
current view of the map to a variety of format 
types including: PDF, JPG, PNG, SVG and others. 
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Layer List: The Layer List contains an extensive collection of BGIS authoritative data layers, and acts as a 
table of contents. It allows users to turn individual layers on and off within the map. 

 
• Each layer in the list has a check box that allows the user to control its visibility 

• The Counties layer is the only one that is visible when the user first opens the application 

• The Parcels layer turns on automatically when zoomed in at least 0.2 mi 

• The Layer List is separated into groups 

• The “Check”  button provides layer visibility controls 

• Some layers when turned on, may not be visible and grayed out within the layer list window 

◊ This is due to a scale dependency and the user must zoom into the map for the layer to appear 
 
 

 
 
 

NJ-GeoWeb Layer List Groupings: This online  
directory contains information, including descrip- 
tions and metadata, for all data layers found in 
the application. It can be accessed on the About 
page in the Information tab or accessed here. 

https://njdep-nj-geoweb-layer-list-search-njdep.hub.arcgis.com/
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NOW IT’S YOUR TURN! 

We’ll now explore some of the layers, as well as the features 
offered in the Layer List 

• Open the Government Data group 
• Using the “Check” button (upper right) select Expand all layers 
• Select the Legislative Districts 
• Click on the layer options (3 dots) and select Zoom to 

◊ Click on the layer options and select Transparency 
• Move the transparency slider bar back and 

forth and observe changes to layers symbology 
on map 

• Click on the Set visibility range option 
◊ The range contains two thresholds for visibility- State 

level and building level 
◊ Move the range indicators, then zoom in/out of the 

map to observe visibility changes 
• Select Show item details 

◊ A new webpage opens, with information about the layer, including creator, metadata, terms of 
use, etc. 

 
 

 
 
 
 
 

Add Data: The Add Data tool enables users to add data to the map from a variety of external 
sources. Data sources include ArcGIS Online, Layer URL’s, or uploading of local files. 

 
Metadata can be viewed by clicking the ‘DETAILS’ button. Users can search for a layer of their choice 
using key words. Through the Title drop-down, the results can be rearranged based on the relevance, 
title, author, rating, views, and date. To search for all NJDEP authoritative data layers, type NJDEP in the 
Search text box. NOTE: Some data may require an ArcGIS Online account. 
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Adding data via ArcGIS Online: Adding data via URL: 
 

 
 

Adding data via a local upload: 
 

Note: Zipped shapefiles have a limit of 1000 features 
 
 
 

NOW IT’S YOUR TURN! 

Let’s add data using the ArcGIS Online and URL methods. 

• ArcGIS Online: 
◊ Click on the “Add data” button 
◊ Under the “Search” tab, type "NJDEP Clinging 

Jellyfish" in the Search text box 
◊ Click Search 

• Click on "Add", to add the layer to the 
map 

• Click on “Details” to review this layer’s 
description, metadata, etc. 

• Click on "Remove", to remove the 
Clinging Jellyfish layer from the map 
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• URL: 
◊ On the “URL” tab, select “An ArcGIS Server Web 

Service" as “Type” 
◊ Click on SAMPLE URL(S), then copy past the “world 

cities” link into the URL box 
◊ Click “Add” 

• Cities within the data set appear in New 
Jersey and surrounding states 

• Click on the city points on the map to 
examine the attribute data in the pop-up 

 
 
 
 
 
 
 
 

7. Attribute Table 

The Attribute Table displays a tabular view of operational layer’s attributes. When more than one layer’s 
attributes display, multiple tabs automatically generate in the attribute panel. Attribute information can be 
exported to CSV through the attribute table. 

 
 

 

NOW IT’S YOUR TURN! 

Let’s check out the functionality of the Powerplants attribute table 

• Open the Powerplants in the “Utilities” group of the “Layer List” 
• Select View in attribute table in the layer’s option button (3 dots) 

◊ The attribute table opens on bottom of map view 
◊ Select a record, then click “Zoom to” 
◊ The map zooms to the site of the record 

◊ Zoom to full extent by clicking on  Home button 
• Let’s try filtering records 

◊ In Options select “Filter” 
◊ Add Expression 

• “County (String) is CAMDEN” 
◊ Attribute table now displays power plants exclusive to Camden County 
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• Try exporting your three Camden County power plants to a CSV file: 
◊ “Options > Export all to CSV”. 
◊ Click OK. 
◊ CSV file is exported to your Downloads folder. 

 

 
 
 

8. Scale Bar and XY Coordinate 
 

The Scale bar provides a visual indication of the size of features, and distance 
between features, on the map is found at the lower left of the map viewer. 

 
The Coordinate tool displays X- and Y- coordinate values on the map and can be 
found at the lower-left of the map view. 

 
• Users can choose from displaying coordinates in: 

◊ New Jersey State Plane (Easting X, Northing Y) 
◊ WGS-84 Web Mercator (Longitude, Latitude) 
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Users search for the coordinate choices by clicking the Enable Map Coordinates tool (“up” button), which con- 
figures for NJSP or WM. 

 
 

Enable to Get Coordinates Configure Web Mercator or 
NJ State Plane 

 

 

 
 
 

 
How to find a State Plane Coordinates 

 

Basic site information needed to locate coordinates: 

• Knowledge of location of street or closest street to project area or street address. 

• Municipality 

• County 

• Zip code 
 
 

Two ways to locate a site: 

• A street address (with a number) or landmark at or near the site. 

• Knowledge of the site location in relation to the municipal boundaries. 
 

NOW IT’S YOUR TURN! 

The best way to demonstrate this process is to do it; let’s go over a few methods 

• Finding coordinates via a street address: 

◊ Go to the “Find address or place” box on the 
upper left-hand side of the map. 

◊ Enter the street address (with number or closest number to the site). Click search. 
 

 
NOTE: (Not all addresses will find a match. The map will zoom to the approximate address. 
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Finding coordinates based on relative position: 

• Enter the municipality name in the “Find address or place” 
box. Select the appropriate value from the drop-down. 

 
• Use the icon to zoom in to the site location. Or hold down the 

left mouse button and move the map around. 
 

• If you zoom in too far, use the icon to zoom out to relocate 
your search in the same relative area. 

 
 
 
 
 

Let’s now find a set of State Plane coordinates 
 
 

• Click on the “Enable to Get Coordinates” tool  . The tool will look like this: 
 

 
• Click on the map to place a marker at your location. 

 

• You will see the coordinates in the lower left-hand side corner:  

• The X and Y coordinates are separated by a space. 

• X Coordinate = 420332.86 Y Coordinate = 505458.36 

• If needed, you can copy and paste these coordinates into your application. 
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Summary of Tools 

 
Descriptions of the tools available in the application are provided below: 

 
 

Tool Description 

  Zoom 

 
Click the plus or minus button to zoom in or out of the 
map. 

  Home 
 

Zoom the map to the initial map extent. 

 
  My Location 

Allows the network to detect your physical location and zoom 
the map to it. 

 

Extents 

 
Navigate the map to its previous or next extent. 

 

  Coordinates 
 
 

 
 

 
 
 
 
 
 
 

 
Click the arrow  on the widget to display a list of 
spatial references specified in the configuration. When 
you choose one from the list, it becomes active. 

 
 
Click on  button to enable clicking the map to get 
coordinates. You can add a point to the map, highlight 
the coordinates, and make a copy of the coordinates. 

 Open Attribute Table 
Query results or select an attribute to view or hide the 
attribute table from the bottom of the page. 
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Summary of Tools, Continued 
 

Tool Description 

 
Find Address or Place 

 

 
 

 
Find locations or search features on the map using the 
NJOIT geocoding service. 

Layer List Tool 
 
 

 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

Check and uncheck the layers in the Layer List or 
the table of contents.  This window can be closed 
or opened by clicking on the Layer List tool button. 

 
 
 

  Click the Search button to find layers within the 
Layer List. 

 
Click the Control All Layers button to control the 
behavior of the layers in the list. You can turn on/ 
off all layers or expand/collapse all layers 

 
 
 

Click an individual layer to show its symbols.  

 
Click the Layer Context menu to enable options 
like: 

Zoom to, Transparency, Set Visibility Range, Disable 
pop-up, Move up/down, View in Attribute Table, Show 
item details. 

Some of these tools may be grayed out depending on 
the scale or layer type. 
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Summary of Tools, Continued 
 

Tool Description 

 Legend 
Display labels and symbols for layers in the map. The 
Legend supports dynamic, tiled, image, feature, KML 
layer types, and WMS layers with an associated legend 
URL. The Legend is automatically updated when the 
visibility of a layer or sublayer changes. When no 
operational layers are rendered in the map, the Legend 
is blank. Base maps are not shown in the Legend by 
default. The order in which layers appear in the Legend 
corresponds to the layer order in the map. The legend 
respects the scale dependencies of the layers in the 
map. 

 Share 

The Share widget allows you to share an app by sending 
an email with a link or embedding it in a website or blog. 
It also provides an easy way to define URL parameters for 
the app. 

  Parcel Search 
Parcel Block & Lot: 

 

 

• Query the parcel layer to locate a block and lot. 

• Select a municipality (required) and enter a block 
number and a lot number (optional) The search will 
return a maximum of 1000 records. 

 
Parcel Number (PAMS PIN ID) 

 

 
 
Enter the PAMS PIN ID of the parcel you are looking for. To 
search for multiple parcels, separate the PAMS PIN IDs 
with a comma. 



31  

Summary of Tools, Continued 
 

Tool Description 

  Add Data 
Add data to the map by searching for layers in the Geo- 
Hub content, entering URLs, or uploading local files 
including shapefiles, CSV, GPX, and GeoJSON. In this 
way, users can temporarily add layers to the map and 
remove them from the map. Click Type to filter the 
results by map service, feature service, image service, 
etc. 
Click Relevance to sort by Title, Owner, Date etc. 

Locate Using 
XY Coordinates 

 
Locate a point on the map using coordinates using State 
Plane New Jersey FIPS 2900 feet 

 
  Searches 

 
Choose from the dropdowns to easily zoom to a county, 
municipality, search for an NJEMS site, watershed or sub- 
watershed. 

  Measure 
Measure the area of a polygon, length of a line, or find the 
coordinates of a point. 

  Draw 

 
Create graphics that display on the map. It optionally 
adds line distance or polygon area to the feature as text. 
The Draw tool enables users to draw basic graphics and 
text onto the map. It provides basic sketching and 
redlining functionality for the web application. It also 
displays some measurements for drawn features, such as 
lengths for lines, and areas and/or perimeters for 
polygons. 
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Summary of Tools, Continued 
 

Tool Description 

  Select 
Select features on the map and take actions on the select- 
ed features. The selected features can be passed on to 
other tools as input, such as geoprocessing tools, 
attribute table, etc. Zoom to the proper extent or the 
layer will display as gray. 

  Basemap 
 

Select from a gallery of basemaps from ESRI aerial image- 

ry. 

  Near Me 
The Near Me widget allows you to find features within a 
buffer distance in feet or miles, of a defined address or set 
location, view detailed information about those features, 
and get the distance of the feature from the selected 
feature. 

 
  Filter 

Users can create their own filters and queries. Any layer 
within the Layer List can be filtered/queried by any 
field(s) to narrow down results. Only the features that 
meet the expression criteria will be visible in the map. 

Accordingly, other tools within the application will 
respond to the change it makes in the layer. 

 
  Swipe 

Compare the content of different layers in a map. Swipe 
provides a vertical view. Slide the swipe tool to reveal the 
content of another layer. To swipe aerial photography, first 
add the imagery using the Add Data tool. Click on the 
Swipe tool and add the layer users want to appear on the 
left side of the swipe bar. 

To remove the swipe tool, click again to disable. 
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Summary of Tools, Continued 
 

Tool Description 

 
 Print 

Connect the web application with a printing service to al- 
low the current map to print. Change the title, layout and 
format as needed. Print in formats such as .jpeg, .pdf, 
.png. 

 Screening Tool 
The Screening widget allows you to define an area of 
interest and analyze specified layers for potential 
impacts. The area of interest can be defined through a 
place name search, by drawing on the map, by uploading 
a shapefile, or by entering a traverse with coordinate 
and distance pairs. Analysis results can be inspected in 
the widget and, optionally, shared via a printed report or 
CSV file down-load. 

 
  More Tools 

This icon will appear when the browser window is not 
large enough to show all the available tools in the 
application toolbar. Clicking on this icon will show the 
additional tools. 
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Tutorial 
 

Use NJ-GeoWeb to answer some example questions provided below. The answers on the 
following pages provide users with step-by-step instructions to solve the problems. 
Answers may have alternative ways to use certain functionalities. Feel free to deviate 
from these topics to explore on your own. 

1. How can I find the coordinates for Rutgers University? The address is 8 College Ave, 
New Brunswick, NJ 08901. 

2. How can I find Groundwater Contamination Areas (CKE) within Cape May County? 

3. How can I compare NJ wetlands data from 2007 to 2012? 

4. What is the total area of the State House Historic District and Mill Hill Historic 
Districts? 

5. I only have the coordinates for a well (-74.1150, 39.7484) that I would like to add on 
the viewer. How do I add the well onto the map? 

 
 
 
 
 

Tutorial Answers 
 

1. How can I find the coordinates for Rutgers University? The address is 8 College Ave, New 
Brunswick, NJ 08901 

• Use the Address Search tool and enter the given address. 

• Click the Locate using XY Coordinates tool on the bottom left-hand corner and place the 
marker on the address search result. 

The coordinates are NJ State Plane 506,825.589 606,317.323 Feet. 
 

2. How can I find Groundwater Contamination Extents within Cape May County? 

• In the Layer list, select Groundwater Contamination Areas (CKE). 

• Also, in the Layer list, open County Boundaries, click on …, select View in Attribute 
Table 

• Scroll down to Cape May County, highlight its row (far right), the click Zoom to in 
Attribute Table tool bar– map will zoom to Cape May County. 

• In toolbar, click Clear Selection. 
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The user can now zoom into Cape May County for closer inspection of the extents, 
symbolized as purple out-lined polygons. Change the transparency levels of the layers to 
make the contamination areas more visible. Note: The basemap used below is Esri Dark Gray 
Canvas to clearly show the CKEs. 

 

 
 
 
 
 
 
 

3. How can I compare the NJ wetlands data from 2007 to 2012? 

• Open the Basemap Gallery and choose “Imagery”. 

• Select Layer List, then Land. Add 2007 Wetlands layer. Check on the 2012 Wetlands 
layer. Enable the Swipe tool and choose Wetlands 2007 to show on the left side of the 
swipe pane. 

• Zoom in to an area to visualize the difference between the wetlands. 
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4. What is the total area of Mill Hill Historic District and State House Historic District? 
 

• Select Layer List, then add Historic Districts. 
 

• Click on … of the Historic District layer and select View Attribute Table. The attribute table 
appears on the bottom of the map. 

 
• From the top left corner of the attribute table, Choose Options > Filter. 

 
 

• Click on “Add expression.” Click the Set input type button and select Unique. From the 

dropdowns, create this expression: Cultural Resource Name is Mill Hill Historic District. 
 

• Add another expression. Change “Display features in the layer that match all …” to Display 
features in the layer that match any …” Click the Set input type button and select Unique. 
The second expression is: Cultural Resource Name is State House Historic District. Click Ok. 

 
• Two results will show in the attribute table. 

 

 
• Scroll to the right of the table and click the field SHAPE_Area > Statistics. A new window 

appears with the sum of the two results. 
 
 
 
 
 
 
 

The total area is 2.538,619.96 



37  

• To determine the unit of measurement, click on … of the Historic District layer and Show 
Item Details. A new tab will open: Click Metadata. 

• Scroll down the metadata page to find the unit under the Attribute_Label: SHAPE.AREA. 
The area is in square feet. Thus, the total area is 2,538,619.96 sq. ft. 

 
 

 

 
 
 

5. I only have the coordinates for a well (-74.1150, 39.7484) that I would like to add on the 
viewer. How do I add the well onto the map? 

 
• Enter the coordinates in “Find Address or Place” text box, Click Search button. When the 

pop up of the coordinates shows, click on … and Add a marker. A blue marker will 
appear. 

• Next, open the Draw tool. Select the place marker or a shape to add the well on to the 
map. 
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Multiple Parcel Search Using the Custom Layer Filter Tool 
 
 

To execute a parcel search on adjacent lots in NJ-Geoweb, use the Custom Layer Filter tool. 
 
 
 

Click on  to activate it. 

Initiate the tool by clicking on the  icon 
in the bottom right corner of the tool’s pane. 

 
 
 
 
 
 
 
 
 
 

Sometimes it may be obscured by the App State warning 
message that appears when you first open NJ-Geoweb. You 
will need to close this pop-up to see the  icon and click on 
the icon. 

 
Once the tool is initiated, make sure the  button in the top-right corner is turned on, 
otherwise the filters being created will not be applied to the layer. 

Alternatively, you can turn this button off  before creating your filter expressions. You 
must remember to turn it back on in order to see the results of the filter tool. 
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1. Select the Parcels layer from the drop-down 
list. 

 
2. Click the Add Expression button on the 
bottom of the tool’s pane.  

3. Change the first parameter to the 
‘Municipality (String)’ field, select ‘contains’ for 
the second parameter, and type in the 
town/city. 

 
4. Click the Add Expression button. Change the 
first parameter to the ‘County (String)’ field, 
leave ‘is’ for the second parameter, and type in 
the parcels’ county for the third parameter. 

 
5. Click the Add Expression button. Change the 
first parameter to the ‘Block (string)’ field, leave 
‘is’ for the second parameter, and type in the 
block number. 
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6. Click the Add Set button on the bottom of 
the tool’s pane.  
Two sets of boxes appear. 

 
7. Change the first parameter to the ‘Lot 
(String)’ field, leave ‘is’ for the second 
parameter, and type in the desired lot number 
for the third parameter. 

 
8. Change the drop-down to say Any of the 
following expression in this set are true 

 

 
9. Repeat this process for your next lot 
number. 

Note: If you need to search for more than 2 
lots, just click the + icon (circled in red) and 
repeat step #7. 

 
 
 

 
9. Click on the Layer List tool. From the list of 

categories, select Base Layers. (If necessary, turn 
the Parcels Data layer on by clicking on the 
checkbox to the left of its’ name.) 

 
10. Click on the More Options icon to the right of the 

layer name and select ‘Zoom To’. 
 

The map will zoom to the selected Parcels. 
 
 

Note: The zoom feature will take up to about 10 seconds to zoom to your selected parcels. 

6 
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